
Urban Forestry South  January 20, 2015 
Urban Tree Canopy Accuracy Assessment: Detailed Workflow 

Landcover accuracy assessment for UTC involves five steps1: 

1. Review narrative methodology for the classification and the accuracy assessment provided by 
the vendor, 

a. For the classification look for discussion points about… 
i. MMU (minimum mapping unit) 

ii. Filling “gaps” 
iii. How ancillary data was used 
iv. Post classification editing to “add” small tree canopy 
v. Other manual editing that affects canopy 

b. For the accuracy assessment look for… 
i. Methodology citation 

ii. Stratification 
iii. Number of random points 
iv. Interpretation thresholds 
v. Use of ancillary data 

vi. Post-assessment modifications 
1. Adjacent region extent around assessment points misclassified 

a. Scale used (e.g. 1:3,000) 
2. Manual corrections vs. rule set change and reclassification process 

2. Make an overall – “does it make sense” quality check – kind of from the point of view of local 
users (i.e. county, municipal, resident) of the information, 

3. In each area of interest (AOI) select about 1,000 random points (stratify as needed) and do a 
visual assessment of the underlying NAIP imagery, 

a. Make Certain that the random point attribute table is sorted in OID order 
b. Create VisClass; assign one of seven classes:2 

i. Tree canopy 
ii. Grass/shrub/low vegetation 

iii. Bare soil 
iv. Water 
v. Buildings3 
vi. Roads (public) & railroads 

vii. Other impervious (parking lots, driveways, sidewalks, airport runways) 
c. In areas with a high proportion of agriculture you may wish to separate fields from 

grass/shrubs 
i. Alternatively grass/low vegetation and bare soil can be identified as 

“agricultural” bay using a zoning or landuse GIS layer 
4. Generate a list of “discrepancies” (points where the vendor’s object classification i..e ObClass 

DOES NOT match the visual classification i.e. VisClass) 
a. Calculate ReviewErrors = VisClass – ObClass where values <> 0 are discrepancies (i.e. 

differences of opinion or errors) 
b. For significant types of discrepancies (e.g. the object classification is trees and the visual 

classification is grass/low vegetation; the most common visual error; usually occurs at 

1 See A Versatile Production-Oriented Approach to High-Resolution Tree-Canopy Mapping in Urban and Suburban Landscapes, 2014, Jarlath O’Neil-Dunne, Sean 
MacFaden and Anna Royar, Remote Sensing (ISSN 2072-4292) for discussion of “accuracy but also high realism and visual coherence” 

2  Or classes used by vendor 
3 Buildings, roads & railroads, and other impervious can be combined into Impervious if desired, if a building footprint layer was used in the object-based 
classification you should probably keep buildings as a separate class 
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the “edges”) investigate possible visual or object-based errors by looking at base NAIP 
and/or NDSM and/or building footprints 

5. Evaluate the accuracy of the UTC classification based on: 
a. Methodology, 
b. Quality check, 
c. Visual classification and error matrix produced, 
d. Vendor’s error matrix (comparison). 

I have found in QA/QC reviews of landcover classification that it is difficult to replicate accuracy 
matrix numbers (hence the use of the Kappa statistic). 

There are probably several reasons for this: 
 My experience, 
 Quality of the imagery, 
 Pixel-based accuracy assessment vs. object-based classification, 
 Probably the consistent application of MMU and/or other post-classification 

aggregation, 
 My lack of knowledge of the physical area (i.e. I’m not familiar with the region; 

particularly where there is a large % of agriculture or undeveloped, wooded land), 
wetlands), 

 I obviously don’t “process” the 4th band, 
 But, on the positive side, I can make the “context” assessments for the area around 

a point (e.g. am I “standing” in the middle of a 40 acre woods and this looks like 
closed canopy), 

 Vendors post-accuracy assessment editing extent and process. 
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GIS workflow4 for accuracy assessment: 

1. Assemble all layers provided by the vendor… 
a. Imagery used for the classification (after any edits are done) 
b. AOI boundary 
c. Canopy height (if LiDAR used)5 
d. “Base” deliverable (i.e. the landcover classification) 
e. Any other ancillary data used in the classification methodology 

i. e.g. Building footprints 
2. Start an ArcMap project for the accuracy assessment 
3. Create a file geodatabase for this accuracy assessment 

a. Import vector layers… 
i. AOI boundary (let this imported layer set the project dataframe projection and 

datum) 
ii. Others (i.e. building footprints, roads, EOP, etc.) 

b. Use the following layers outside of the geodatabase 
i. Imagery (raster) 

ii. Vendor’s UTC classification (raster) 
iii. nDSM (LiDAR) height above ground (usually very large and may require an 

external drive) 
c. Generate a set of random points within the AOI6… 

i. ArcToolbox=>Data Management Tools=>Feature Class=>Create Random Points 
ii. Restrict minimum distance to at least 100 meters (if AOI is large enough) 

iii. Use a feature class (points) name like “AOI_Random_100” e.g. 
Louisville_Random_100 

d. Using the random point layer (3ciii), extract the UTC classification value at each point… 
i. ArcToolbox=>Spatial Analyst Tools=>Extraction=>Extract Values to Points 

ii. Use a feature name like “AOI_Class” e.g. Louisville_Class 
iii. The new point layer will have a new attribute called “RASTERVALU” 
iv. Convert the attribute RASTRVALU (classification) to ObClass (object-based 

classification); accomplish  this by creating a new integer attribute, and using 
‘Field Calculator’ to assign RASTRVALU to the new attribute 

v. Delete the attribute RASTERVALU 
e. If you have LiDAR data, use the new point layer (3dii), and extract the nDSMn value at 

each point… 
i. ArcToolbox=>Spatial Analyst Tools=>Extraction=>Extract Values to Points 

ii. Use a feature name like “AOI_ClassLiDAR” e.g. Louisville_ClassLiDAR 
iii. This new point layer will have a new attribute called “RASTERVALU 
iv. Convert RASTRVALU (canopy height) to nDSM or CanopyHt (height above 

ground); accomplish  this by creating a new integer (or float) attribute, and 
using ‘Field Calculator’ to assign RASTRVALU to the new attribute; if the new 
attribute is integer use nDSM = Int (RASTERVALU + 1) in the field calculator 

v. Delete the attribute RASTERVALU 

4 All or a portion of these protocols/procedures can be developed into an ArcGIS toolbox 
5  Normalized Digital Surface Model (nDSM) or height above ground raster 

6 This may involve a stratification scheme 
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The process may proceed like this: 
 double-click point 
 look at nDSM value in attribute table  

and point  on map 
 zoom in more if necessary 
 ‘clear selected’ to get a better look at 

exact location 
 make the nDSM raster visible  
 assign class 

Considerations: 
 evaluate nDSM height in visual context 

of the surrounding area 
 nDSM > 8’ and point in wooded area; 

class is probably tree canopy 
 use nDSM values below 8’ as shrub 

(most often) – or determine an 
appropriate height cut-off 

 in residential settings, nDSM in the 8’ – 
12’ range may be small buildings; in 
the 3’ – 5’ range a picnic table or 
doghouse! 

 nDSM near zero will usually be grass, 
pavement, soil, ag field, or water; 
however some water gives bogus 
readings on height >50! 

 nDSM values of zero or near zero may 
still be tree canopy since LiDAR is 
usually (often) taken leafoff and the 
LiDAR missed all branches 

 nDSM values between 10-100+ might 
be trees or buildings; don’t assign a 
tree canopy class to hastily 

f. Open the new layer of random points with the classification & LiDAR (optional) values 
appended (from step 3d & optionally 3e)… 

i. Recalculate the attribute CID = OID + 1 (create a ID attribute if necessary) 
ii. Add a short integer attribute, VisClass 

iii. For later use, create an integer attribute ReviewErrors (see 4bvii1(1)) that 
follows) 

iv. Optionally, add a text attribute Visual_Notes (length 32 – 64 characters) 
g. Open the layer properties for “AOI_Class” or “AOI_ClassLiDAR” and in the Field tab 

check  ONLY CID and VisClass (and optionally the nDSM value if you have LiDAR); leave 
ObClass, Shape, and OID unchecked – OID and Shape are not needed; ObClass is the 
classified landcover value; to assure an unbiased visual classification you DON’T want to 
know what class has been assigned by the vendor.  If you crated Visual_Notes you 
should also check  it. 

4. Begin the visual classification of the randomly selected points: 
a. To be valid, the visual assessor must not know the results of the object classification (i.e. 

remove all bias possible) 
i. ObClass must NOT be visible in the classification table you are creating 

ii. Vendor’s UTC classification layer should also be OFF 
b. In your project, make the following layers visible… 

i. AOI boundary 
ii. AOI_Class or AOI_ClassLiDAR (label these features with the OID) 

1. Set the symbology of VisClass to something like  in a color that has 
good contrast across the NAIP image; or use categories that will update 
and display points as you evaluate the imagery: 

 
2. Set the labels to OID and also in a good contrasting 

color and size 
iii. nDSM image (above NAIP in the TOC) – leave unchecked (not 

visible) 
iv. NAIP image 

c. Open the AOI_Class or AOI_ClassLiDAR attribute table 
i. Position so that all two (three) attributes are viewable 

1. OID, VisClass, nDSM and Visual_Notes (optional) 
ii. Start an editing session for this feature class 

iii. Double-click on each point in AOI_Class or AOI_ClassLiDAR 
1. The map view will zoom to the point 
2. Visually evaluate each point based on the NAIP (and 
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nDSM value if available) 
a. After you locate the point you can ‘Clear Selected Feature’ to 

get rid of the blue selection symbol 
3. Enter the appropriate numeric code for the class (for example) 

(1) Tree Canopy 
(2) Grass/Low Vegetation (Shrubs) 
(3) Bare Soil 
(4) Water 
(5) Buildings 
(6) Roads & Railroads 
(7) Other Impervious 

4. On image areas that represent dry grass, base soil, or fields that appear 
to be planted you may want to toggle the vendor’s landcover layer on & 
off to gauge how the interpretation treated these (these are often quite 
difficult for visual interpretation) 

5. About every 50th point, toggle the vendor’s landcover layer on & off to 
visually assess the interpretation for an area about 1 mile square 
(1:10,000 map scale should work); if you see any classification of 
concern make short notes in the Visual_Notes attribute 

6. Double-click on the next point and continue 
a. Save your edits frequently! 

iv. Complete the visual assessment for all 1,000 random points 
5. Accuracy Matrix development 

a. Populate the cell values from Excel 
i. Open AOI_Class (or AOI_ClassLiDAR) and “turn all fields on” 

ii. Export the AOI_Class to a shapefile (to create a DBF file 
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iii. Open the exported AOI_Class DBF in Excel 

1. Save it as an XLS (or XLSX) file 
2. Create a Pivot Table from the attributes (Insert => Pivot Table)… 

a. ObClass 
b. VisClass (VisualClass in the example screenshot) 

2. Make the VisClass the rows (drag to Row Labels) 
3. Make the ObClass the columns (drag to Column Labels) 
4. The values will be the count of VisClass 

a. Drag VisClass to ∑ Values  
b. Right Click 
c. Click on the drop-down menu and select Value of Field Settings 
d. Select Count 

b. Open the Excel spreadsheet template for the accuracy matrix 
i. Enter the cell counts (from the Pivot Table) into the accuracy matrix 

c. Evaluate the user’s, producer’s and overall error 
i. In ArcMap open the AOI_Class (or AOI_ClassLiDAR) attribute table 

1. Calculate ReviewErrors = VisClass – ObClass 
2. Following this calculation, <>0 values will be points where the vendor’s 

object classification DOES NOT match your visual classification 
3. For significant discrepancies (e.g. the object classification is trees and 

the visual classification is grass/low vegetation; the most common visual 
error) 

a. In ArcMap, make a selection by attribute for ReviewErrors <> 0 
b. Open the attribute table and restrict the view to only those 

records selected 
c. Sort this subset of the attribute table by ObClass (or VisClass) 
d. Double-click on mismatched classifications where ObClass = 1 

(Trees) 
e. Compare differences using the NAIP (and nDSM) as background 

6. Prepare a report on the accuracy based on… 
a. Your error matrix compared to the vendor’s error matrix: 
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i. Overall percentage coverage by each classification 

ii. User’s error by classification 
iii. Errors of omission and commission 

b. Specific points where you visually evaluated an area (see 4biii5) 
c. The results of a review of all ReviewErrors) 

i. What was the reason for the discrepancy 
1. Poor imagery 
2. Evaluating an “edge” 
3. Shadows from tall buildings or trees 
4. Visual interpretation error 
5. Object classification error 

Notes7 About Normalized Digital Surface Model (nDSM): 

The Normalized Digital Surface Model (nDSM) or height above ground raster may have some spurious 
values.  Use a min-max stretch and set the low/high values as 0/50 for symbology.  The LiDAR has better 
horizontal accuracy than the NAIP and thus is a good foundation for tree canopy delineation except in 
those cases where it underestimates tree canopy due to the leaf-off nature of these datasets. 

7 Edited from Jarlath O'Neil-Dunne | University of Vermont | Spatial Analysis Laboratory 
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